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Chapter 1: Introduction
1.1 What is TracerPlus?

TracerPlus is the central title in the family of TracerPlus Mobile Data Collection and Integration
applications. In tandem with the free PC based design and deployment software TracerPlus
Desktop, the TracerPlus mobile client application provides all the necessary tools to easily
create and manage enterprise class mobile data collection applications. The TracerPlus mobile
client itself serves as a platform on the mobile device. Your custom apps are then created in
TracerPlus Desktop and deployed to the mobile client for use in the field.

A TracerPlus application is typically divided into sub-applications/electronic forms called
Sessions. At its most basic level, a session can be considered an electronic data entry form on
the PDA, with an underlying database table. Each session is configured to contain/control a
particular user process (e.g. Warehouse Receiving) while an overall TracerPlus application might
be made up of many sessions (Receiving, Shipping, Inventory, etc). It’s now easier than ever to
match data scanned into these sessions directly into your existing databases.

Although TracerPlus retains the ability to manually import and export data between existing
databases and mobile devices using text files, automated advanced data integration is possible
via one of three software programs developed to work hand in hand with the TracerPlus Mobile
client. TracerPlus ODBC Link is available for batch (USB) data transfer to almost any database.
For real-time sharing over WIFI/WAN and Cellular networks to those same

databases, TracerPlus Wireless Server is available. Lastly, with the release of TracerPlus
Connect for Microsoft Excel, it's now possible to sync data directly with Excel™ spreadsheets.

TracerPlus is also commonly connected to management systems including Service Alliance,
Remedy, HP Asset Center and PeopleSoft (now Oracle).

If you or your company have a data collection need, TracerPlus is the right choice. TracerPlus is
compatible with most Windows Mobile, and CE.Net terminals. In particular, TracerPlus is
extremely well suited for barcode enabled terminals offered by Motorola/Symbol, Intermec,
Honeywell (formerly PSC), Datalogic and many other manufacturers.

Common TracerPlus Applications

Inventory Management
Fixed Asset Management
Field Inspections

Mobile Sales

Route Accounting
Attendance/Event Tracking
Remote Store Management
Computer Management
Job Material Management
Time Tracking

Event Attendee Tracking
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All users of TracerPlus should use TracerPlus Desktop to build their mobile forms. Although this
manual does provide detailed instructions regarding how to create some applications directly
on your mobile device, these instructions are primarily to provide backwards compatibility to
user of TracerPlus 4 and earlier. Download TracerPlus Desktop free of charge here. Many of the
newer and more powerful features of TracerPlus can ONLY be configured through TracerPlus
Desktop.

sh A 1hroughout this manual, this icon will alert you to the fact that the following
SeldUl2]  hrocess should be completed using TracerPlus Desktop whenever possible.

1.2 New Features in TracerPlus Version 7.0

TracerPlus 7.0 builds on the already vast collection of advanced features, making TracerPlus 6.0
a truly exceptional data collection tool. These new features include:

e Email and text message capabilities for instant reporting and alerts

e RFID tag writing support

e RFID Tag Scanning now supports reading multiple tag memory banks

e Data Lookup capability for all field types

e SmartForm: Directs scanned data to pre-defined field

e Dynamic Parsing

o Keep Alive: Provides the option to maintain the connection to Wireless Server
between data transfers.

These new capabilities added to the existing tools of earlier versions make TracerPlus more
powerful, more intuitive, and faster than ever. Other particularly powerful features introduced
in previous versions (primarily accessible via TracerPlus Desktop) include:

e Data View visible Within Entry Screen with live editing through placement of a
Grid Control

e Configurable Font Size, Color and Style

e Custom Colors for Tabs, Labels, Buttons and other Form Controls.

e Custom validation error messages

e Configurable goto field on validation errors

e Native Motorola RFID and Micro Kiosk support

Ability to launch external applications from the TracerPlus Entry Form

Conditional Lookups with AND / OR relationships

Re-designed Calculation configuration tab improves abilities and ease of use

Image Lookups

e One to Many - Record updates based on settable key fields

e Live license registration via TracerPlus Desktop

e Duplicate/Move Sessions within a Project

e Configurable Launcher

e Performance improvements in Data Entry area for calcs/lookups/data display
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e Custom login profiles to manage multiple users

e Full screen mode offers more real estate on device screen

e Configurable Camera/Image Capture Field Types. (Professional version only)

e Integrated Wireless Capabilities (Pro only-Requires one license of TracerPlus
Wireless Server installed on a host PC or Server).

e TracerPlus Desktop import support added (Import previously created applications
from PDAs directly into TracerPlus Desktop for quick and easy editing.)

e Windows Mobile 6.x Compatible.

e 3G Wireless network support (requires 3G mobile device).

e TracerPlus SmartConnect directs wireless data though WIFI when available.

e Added SQLCE database support, allowing 400% more data.

e Improved WWAN/WIFI connectivity including auto-connect.

e Expanded Customization features including RFID configuration, up to 251 entry
fields and Janam XM65 support.

e Improved filtered dropdown performance.

e Custom validation audible sounds supported.

e Significant performance improvement in wireless look-up speeds.

e User configurable database location (Storage card, custom folder, etc).

e  Maximum record capacity increased from ~20k records to > 100k+ records.

e Expanded the range of supported printers and mobile terminals.

e Improved Entry Form Skin features.

e Keyboard Shortcuts added to support Non-Touch screen devices (MT2000,
MC1000, WT Series)

For a full list of the features in TracerPlus and TracerPlus Desktop,
visit: http://www.tracerplus.com/tracerplus/feature matrix.php
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TracerPlus is available in two Editions; Standard and Professional. One of the features available
in the Professional version of TracerPlus is the ability to use Inter-related (lookup) tables,
enabling users to define sessions that reference other sessions for field data. This not only
automates a number of steps by pre-populating specified fields, but significantly reduces the
potential for error. Common uses for this feature include incorporating price lists and part lists
into a mobile sales application, using previous inspection conditions to monitor maintenance
schedules and referring to address or other locations to assist in validating Inspection
procedures.

TracerPlus also includes the ability to include an extremely powerful and flexible Mobile
Printing component. The ability to print is included in TracerPlus Professional and available as a
separate purchase as a plug-in with TracerPlus Standard. The ability to print via TracerPlus
enables users to print individual records and reports directly from the PDA. Any number of user
configurable reports are available for printing receipts and labels in the field. Have a wireless
network printer? TracerPlus now supports this feature. Simply enter the IP address and port
and TracerPlus data will print to a local wireless printer.

For more information about the differences between the Standard and Professional Editions,
views the TracerPlus Feature Matrix at www.tracerplus.com

1.3 Free Trial

TracerPlus is provided on a trial basis for no fee in order to offer businesses the opportunity to
gain hands on experience with the features and advantages of the TracerPlus suite of
applications. In addition, TracerPlus Desktop is provided entirely free of charge, allowing for an
extended opportunity to experiment with creating mobile forms.

The limitations of the trial download restricts the session usage to 3, only allows 5 records to
transfer to and from a database and provides only a limited print capability. Once purchased, a
Registration Code will be provided via a personalized process. This Registration Code will unlock
all limitations, enabling it for full use without the need for reinstallation.

14 Learning TracerPlus and Using TracerPlus Desktop

Prior to the release of TracerPlus Desktop, TracerPlus mobile applications were configured on
the PDA. With the many features introduced in version 7.0 and the increased integration
TracerPlus Desktop 7.0, this has not only become obsolete but also limiting in that certain new
features can only be enabled and configured using TracerPlus Desktop. The majority of the
configuration and administrative sections of this manual are provided for legacy users of
TracerPlus 5 and earlier as a comparative source.

Note: Download TracerPlus Desktop and read the TracerPlus Desktop Manual for information on
creating your mobile applications.

For additional help, PTS has also provided a series of training videos that provide insights and
tips about how to best use TracerPlus. These videos can be can be found at www.tracerplus.com
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1.5 Integrating TracerPlus using either Batch or Wireless Modes

TracerPlus is available in both batch and wireless versions allowing users to send data via
ActiveSync or connect wirelessly to a data source to a host PC. This flexibility makes it possible
to integrate TracerPlus with most programs and databases. Below is a list of the more popular
programs and databases TracerPlus can integrate with.

Excel (via TracerPlus Connect)
Microsoft Access

Microsoft SQL Server

Oracle

MysQL

People Soft

FileMaker

FoxPro

Most other ODBC compliant databases

TracerPlus is pre-configured to operate in batch (USB) mode, which transfers data via
Microsoft® ActiveSync (Windows 2000, XP) or Windows Mobile Device Center (Vista, 7) when
the mobile device is physically connected to the host PC. As mentioned above, data can be
manually transferred in one of six user specified file formats or via one of two configurable
alternatives designed to simplify and automate the process; TracerPlus Connect for Microsoft
Excel and TracerPlus ODBC Link (for most standard database systems)

For more detailed information about manually transferring data TracerPlus batch file formats
and how they can be configured, see Chapter 4.

TracerPlus can also operate in wireless mode, allowing multiple users to view, edit and share
data from a centralized database over a wireless network in real-time. In order to enable
TracerPlus wireless capabilities, TracerPlus Wireless Server must be installed and configured on
a host PC or Server. In addition, users of TracerPlus Standard require one copy of the Wireless
Plug-in for each license installed on a mobile device. TracerPlus Professional is provided with
wireless capabilities and as a result does not require the additional purchase of the
aforementioned plug-in.

TracerPlus Standard Users: To learn more about the TracerPlus Wireless Plug-in, refer
to Section 7.1.
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1.6 TracerPlus and Barcode/RFID enabled Devices

TracerPlus is designed to speed data entry with or without a barcode enabled PDA. Drop-down
menus, time/date stamps and auto submit features allow users to collect data faster and more
accurately. However, to take advantage of the full power of TracerPlus, we recommend using a
barcode enabled PDA. A partial list of the current (and past) barcode enabled PDAs supported
by TracerPlus are listed below.

In addition to the growing selection of barcode enabled Windows Mobile and CE devices
available, RFID (Radio Frequency Identification) is becoming more commonplace. In response,
TracerPlus now supports Motorola RFID natively and PTS can work with you to develop RFID
solutions with other devices.

Currently Supported Windows Mobile 2003, 5.x, 6.x, Windows CE, and CE.Net Barcode and
PDAs Terminals include:
Symbol PPT8800 Series
Motorola MC35 Series
Symbol MC50 Series
Motorola MC1000 Series
Motorola MT2000 Series
Motorola MC55MC55a Series
Motorola MC65 Series
Symbol MC70 Series
Motorola MC75/MC75a Series
Symbol MC3000 Series
Motorola MC3100 Series
Symbol MC9000 Series
Motorola MC9500 Series
Motorola ES400 Series
Motorola WT4000 Series (Wearable)
Motorola MK500 Series (Kiosk)
Motorola MK4000 Series (Kiosk)
(Note: Symbol is a division of Motorola)
Most Honeywell devices (HHP, MetrolLogic)
Most Intermec devices
Most Unitech devices
Most Opticon devices
Most Datalogic devices (PSC)
Most Psion devices
Most Janam Windows Mobile Devices
TracerPlus with Socket Plug-in scanner is compatible with the following devices:
IPAQ
Dell Axim
Most Casio Handhelds
Some Windows Mobile cell phones and PDAs (excluding Windows Mobile Phone Edition)
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1.7 PTS Support

As a registered TracerPlus user, you receive free e-mail support for 30 days from the date of
purchase. During this period, we are available to answer TracerPlus questions as well as general
bar code questions. Our goal is to provide TracerPlus users the tools and information to
capitalize on the efficiencies of bar code data acquisition. Please visit www.tracerplus.com to
learn more. To contact PTS technical support, please e-mail support@tracerplus.com.

PTS is now offering Comprehensive Support Agreements, including phone support and free
software upgrades during the support plans active period. One and three year plans are
available. For more information, contact your authorized reseller or PTS directly.

Additional Support and Educational References:

An easy to use knowledge base is available for all users to answer the most common
TracerPlus questions. The knowledge base is located at www.tracerplus.com/kb

PTS provides a series of free training webinars over the course of the year, with regular
announcements via email. To begin receiving these announcements, join our Mailing List.
Some of these webinars are also recorded and posted on www.tracerplus.com in order to
provide a more flexible alternative to those unable to attend our live demos.

PTS also hosts a TracerPlus User Group. The group was created to offer our users a
communication channel in which to discuss TracerPlus. You can join the TracerPlus User

Group at Yahoo Groups

The TracerPlus.com Solution Center provides sharable mobile application samples with the
TracerPlus community. TracerPlus.com will serve as a central hub for providing solutions,
services, reseller and partner information as well as providing an outlet for other aspects
regarding the TracerPlus software family.

1.8 PTS Services
Custom Application Setup Service (Session Setup)

If you do not have the time to learn TracerPlus, our Custom Application Setup Service may be
an option. A PTS representative or authorized Solution Partner will work with you to create a

session that meets your specifications. After the session is developed they will train you in the
use of the session and will work to fine tune it to your exact needs. This service is like having a
custom program developed at off the shelf prices. Additional information can be found at

our TracerPlus Solution Center.
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Chapter 2: Installation

This chapter explains in detail the steps for installing TracerPlus. To launch TracerPlus after
installation, tap the Start Menu on the mobile device, then open your Programs Folder and tap
the TracerPlus icon.

2.1 System Requirements

e  Windows 98/NT/2000/XP/Vista/7

e ActiveSync version 3.5 or higher for 98/NT/2000/XP users.

e Windows Mobile Device Center for Vista and Windows 7 Users

e A PDA or bar code enabled terminal running Windows Mobile (Windows Mobile
Embedded), Pocket PC, CE version 3.0 or higher or CE.Net.

e TracerPlus Professional Wireless requires a host PC or Server with TracerPlus Wireless
Server installed.

e TracerPlus Standard Wireless requires the Wireless Plug-in in addition to a host PC or
Server with TracerPlus Wireless Server installed.

Note: References and instructions relating to ActiveSync in this manual also apply to the
Windows Mobile Device Center on the Vista operating system. Naming procedures of future
versions of the proprietary Windows syncing software is controlled by Microsoft and subject to
change without notice.

2.2 Installation using TracerPlus Desktop

With TracerPlus Desktop installed on your PC, first connect your device to your PC and allow
ActiveSync or WMDC to launch. Select Install TracerPlus to PDA from the TracerPlus Desktop
Tools Menu. Follow the onscreen prompts. You will be instructed to complete the installation by
following instructions on the PDA. Installing TracerPlus via TracerPlus Desktop does not create a
separate Start Menu folder. All documentation is included within the existing TracerPlus
Desktop Start Menu folder.

2.3 Installation via the .exe File

1. Download tracerp_ppc.exe from TracerPlus.com or another authorized reseller.
2. Connect Your Device to your PC. Allow ActiveSync or WMDC to launch.

3. Double-click tracerp_ppc.exe to launch the installer.
4

Follow the standard installation instructions. During Installation you will be
asked to complete the process on the PDA.

After Installing, you will have a TracerPlus 6 folder in your PC Start Menu. This will
provide access User Guides, Registration info and an installer link to install to
additional PDAs

TracerPlus 7 for Windows Mobile/CE 11



http://www.tracerplus.com/downloads/mobile_software.php�

24 Purchasing and Registering TracerPlus

As previously mentioned the initial TracerPlus installation is offered as a trial and therefore
requires purchase and registration for full functionality. TracerPlus can be purchased via
authorized resellers. Visit www.tracerplus.com for more information. Registering TracerPlus
removes the functionality restrictions of the trial/evaluation without requiring re-installation to
the device. Additional benefits of registration include 30-days of free support, upgrade news
and future promotional opportunities.

sk DESKTOP!
L~ OPTIMIZED

Registering licenses of TracerPlus has been simplified through TracerPlus Desktop. This method
is described in detail in Chapter 10 of the TracerPlus Desktop manual

However, TracerPlus can still be registered without TracerPlus Desktop. To register TracerPlus,
we require the Device ID of the mobile device, a Redemption Link, and an E-mail address.

The Redemption Link is a unique ID generated for each license of our software you have
purchased and emailed to you. TracerPlus is registered by pairing this Redemption Link with the
Device ID of a particular mobile device. The Device ID can be found on the TracerPlus splash
screen.

Irel c=2nsyus

@ 2002-2010 v 600
* UNREGISTERED *

Device ID: 445643450506F636 |

Portable Technology

e .P Salutions

wewwwe, tracerplus. com

Mohilize your data Today!

Mode: |F‘mfessiona| v|

| Try It | ‘Register ‘

File Options Admin Help 1]

When entering this information manually, it is important that you copy the Device ID exactly as
it appears on the TracerPlus splash screen; capitalization and spacing are critical. The ability of
TracerPlus Desktop to register devices removes this potential problem by automatically
detecting the Device ID.

It is also important to select the proper mode (Standard or Professional) that you purchased.
Failing to do so will result in a registration error.
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How to Register without using TracerPlus Desktop:

2.5

o N o U

After purchasing TracerPlus, you will receive a Redemption Link email. When
purchasing multiple licenses, you will receive an email with multiple Redemption Links.

Confirm that the most recent version of TracerPlus has been installed on your mobile
device, and then locate the Device ID by launching TracerPlus. The Device ID is
highlighted in the above screen shot.

On your PC, click on Start Menu = Programs = PTS = TracerPlus 6, and select
Registration Info. This will direct you to the registration section of www.tracerplus.com.
Complete, review and submit the Registration Info form.

Once this step is completed, your registration code is e-mailed to the address provided.
This process usually takes one hour but we ask that you allow one business day in the
event of heavy traffic or any other delay.

After receiving your code, restart the TracerPlus application on the mobile device.
Click the Register button in the TracerPlus Splash Screen.
Enter your Registration Code at the Code prompt.

If the Registration Code is valid, you will receive a Thank you for Purchasing TracerPlus
message.

Removing TracerPlus

In the unlikely event that you would like to remove TracerPlus from your PDA, follow these
simple instructions.

Use the Add/Remove Programs feature in MS Windows via control panel to remove PTS
TracerPlus from your PC.

On your PDA, navigate to Start = Settings = System = Remove Programs. Highlight
TracerPlus and select Remove.
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Chapter 3: Navigating TracerPlus
Once sessions and fields have been configured, the applications deployed and the method of
data exchange has been determined (OBDC, Wireless, Excel, etc), TracerPlus is ready to begin

collecting data. The processes of data entry, collection, administration and exchange are
outlined below.

3.1 Entering Data
To enter data in TracerPlus, the user must first select the appropriate session.

~ 1. Click on the Data Entry tab
2. Select the appropriate session.

Configure | Data Entry

Inventory Item List

A

Last Sync: nfa
File Dptions Admin Help O

Entry Screen

The Entry Screen is the area in which the user enters data. The fields are presented to the user

with the customized fields as they were configured. The user enters data for each field

presented. When the data is being scanned, the system controls the flow to the next field based
on the Field Settings previously set up. This screen contains three buttons. These are discussed

below.

TracerPlus 7 for Windows Mobile/CE
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%% | PTS TracerPlus o T 2

Records: O

10002326

Session 02

[24 |
PvC valve M (53
S
22504 |
|FedEx A |
10070 |

DEEE
T

File Dptions Admin Help T}

Done Button

Click the Done button when you have finished entering data and would like to return to
the Launcher. You will be prompted as to whether you would like to save the last
record. Answer appropriately. You will now be returned to the Launcher.

Submit Button

Clicking the Submit button submits the current record to the database. After clicking this
button, the focus is set to the field that was set as the Session Start On field. Refer to
Section 3.2.1 for more information on setting a Start On field.

Clear All Button

Clicking the Clear All button clears all data from all fields for this record. Notice that the
focus will reset to the ‘Start On’ field. Also notice that any Default values selected in the
Field Settings are not recognized. Fields set to read-only are not cleared.

Refresh Button

The refresh button is displayed to the right of any Lookup, Calculated, or Filtered Drop
Down Field. When this button is pressed a refresh of this field is performed using the
appropriate logic for that field.

Note: A lookup and re-calc is also performed on a successful scan or down arrow key press.

3.2 Editing Data from the View Data Screen
The View Data Screen is the area where the user can review, edit and search for records

previously entered. The user can delete or edit a record by selecting it and then tapping a
function key. To learn more about record searching, refer to Section 5.4.
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To access the View Data Screen:

1. Select the View Data tab.
[ 2. Select the appropriate session.

TrEeEipius

[ Configure | Data Entry | Wigw Data
B B

Inwentory Itern List

Last Sync: nfa
File Options Admin Help m O

This will open the View Data Screen shown below.

Ttern List Records: 0

Part Nurnber | Quantity | Descrip...

L[>

4 ] [ 1™
|Part Murnber v|| || E
| Delete | | Edit | | New |
File Options Admin Help O
Delete
Click the Delete button to delete the selected record.
Edit
Click the Edit button to edit the record in the Data Entry screen.
New
Click the New button to add records in the Data Entry screen.
Delete All

To delete all records from the session, select Options—>Delete All. This will remove all
records from the session.
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Note: When the data table is filtered, performing a Delete All will remove records that
match the currently set filter.

3.3 Quick Buttons

TracerPlus specializes in streamlining screen interaction. We do this through implementation of
several unique features. This allows for very fast and accurate data entry. One of the features
to aid in this is using the Up/Down/Enter keys on your PDA.

The Up Arrow key allows the user to move up one field on the Entry Screen. Note that this does
not follow the ‘Go To’ field settings. It simply moves up one field on the Entry screen.

The Down Arrow and Enter keys allow the user to move down one field in the Entry Screen.
The Down and Enter keys are actually used to trigger the ‘After Scan’ rules and TracerPlus
behaves just like it would after receiving a valid bar code scan. If, for example, the Auto Submit
flag is enabled for the current field, and the user presses the Down Arrow or Enter key, the
current record is submitted and all of the After Scan field settings for the field are respected;
including the ‘Go To' Field. This is especially useful for the users that do not have a bar code
enabled PDA.

3.4 Finding Data
While in the View Data Screen, TracerPlus users can search the session database by using the

Filter feature. Follow the directions below to use the Filter feature.

r 1. Select a field to search. — 2. Scan or enter data into the Filter Field.
3. Click the Filter button. ‘

1 0 4 2 70 o
Ttermn List Records: 1 [tem List Records: 1
Part Mumnbier | Quantity | In Stocl Part Nurnber | Quantity | In Stoc
123000000016 O False 123000000016 O Falze

Cuantity

Description

In Stock

Eg;:rlzr ] [» [ | Il i T [ |

Part humber g | B ] part hurgber  ~| 123000000016 | mJ
Delete | [ Edit | [ New | [Delete | [ Edit | [ New |

File Options Admin Help 0 File Options Admin Help Q

If you are manually entering data, you must click the Filter button. If you are scanning data, this
is done automatically when you scan a bar code value. Additionally, there is a session setting
that enhances the operation of this Filter feature. By enabling the Edit on Scan/Find in Grid
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checkbox in the TracerPlus Desktop Session Settings, TracerPlus will allow you to change the
data after locating a specific record. You can also set this on the device by setting the option to
Edit on Find. Refer to Section 3.2.1 for more information regarding these PDA settings.

Removing the Filter
To remove the filter, simply press the Filter button again. This will refresh the data grid and
display all data in the current session.

Note: Using a filter, multiple records may be found in the table. When using the Edit on Find
feature, the first value in the filter will be displayed in the Entry Form.

3.5 Sorting data from the View Data Screen

Clicking on any column header in the View Data Screen allows for ascending or descending
sorting. By clicking on the column headers the data in the View Data Screen can be sorted in a
number of different ways. By tapping a column header you will get the following results:

Tap once to sort the grid in ascending order.
A second tap sorts the grid in descending order.
A final tap returns the grid to displaying the data in ‘natural’ order.

3.6 Accessing Wireless Status Information

The wireless status icon allows the user to determine whether they are connected to a wireless
network. Live mode is when a TracerPlus user is connected to the Wireless Server and sharing
data real time over the user’s wireless network. In Offline mode the user is collecting data and
saving locally on the PDA. This data can then be sent wirelessly back to the Wireless Server
when a network connection is made using the Wireless Status form. To access the Wireless
Status form, click on the Wireless Status toolbar icon or navigate to Options=> Wireless Status.

fir X0
Irventory B Records: O

Part# |User |T|:|tal |

[Part# | |

| Delete | | Edit | [ MNew |

File Options Admin Help [T]< )
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After selecting the Wireless Status option the following dialog will be displayed.

,f' |PT5 TracerPlus & Ty 4% ok

Connection Status Offine Info

Last Message:
(none)

Records Pending: 0
with Errors: O
rSelect Mode
Current Made: Live

@/ Live @ |Offline
- = -

Live

Pressing the Live button will close the Wireless Status form and set the user in Wireless Live
mode. If the user is already in Live mode they will remain in this mode. When in Live mode
no data is stored locally on the PDA, it is sent back to the Wireless Server. If a wireless
connection is unavailable, TracerPlus uses its integrated Store and Forward Technology to
save the data locally until a connection is established.

Offline

Pressing Offline will close the Wireless Status dialog and switch the user into Offline Mode.
If the user is already in Offline mode they will remain in this mode. Offline mode allows the
user to collect data and store it locally on the PDA.

Connection Status Tab
The Connection Status Tab displays any information regarding the current wireless
connection settings.

Current Mode Label
The Current State Label at the top of the form displays the current mode, the two possible
options are Live and Offline mode.

Last Message
The Last Message information box will display the last error message to come from the

Wireless Server or any pertinent connection information requiring the user’s attention.

Records Pending
Displays the number of records stored locally in batch mode.

With Errors
Displays records stored locally which failed during send.
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f' |PT5.Tral:erP|us o 7?‘ < [ok

| Connection Status | Offine Info

Records Pending: 0

wWith Errors: O

Err_Code | status [parte Juser [«

4] ] [ D -]
| Edit || Delete | [Delete all|

rSelect Mode
Current Mode: Live

@/ Live @ Offline
- = -

Offline Info Tab

Select the Offline info tab to view data collected when in Offline Mode. From this form
queued records can be sent to the Wireless Server, or modified. The grid displays all records
currently queued. The first two columns in the grid are Err_Code and Status. During a batch
send if the record fails to post the error will be displayed in these two columns

Records Pending
Displays the number of records stored locally in batch mode.

With Errors
Displays records stored locally which failed during send.

Send Now

Press the Send Now button to send all locally stored records to the Wireless Server. While
the transfer is in progress a count will be displayed of the number sent and the total
records. If any records contain errors they will save locally along with an error code and
status.

Edit
Select a record in the grid and press Edit to open the record in the entry form for editing.
This is only available in Offline mode.

Delete
Select a record in the grid and press Delete to delete from the local records.

Delete All
Selecting Delete All will remove all the Offline records from the current session.
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3.7 Print Prompt Dialog

When File = Print is selected the following printer dialog is shown.

Print...

Report: [Receipt.rpt ]

() All records m
(®) Current record 2

() Where:

| | =
| |

Select Select record(s) to print

Cancel

This dialog allows you to select specific records to print. The options include all records, current
record or use a filter to choose a range. To set a filter:

1. Select the field to filter on from the drop down.

2. Enter filter criteria.

Note: The Print Prompt Dialog box is not editable when the “Start Print Automatically” option is
checked in TracerPlus Desktop and will only appear momentarily before printing begins.

3.8 Message Prompt Dialog

When File->Message is selected the following messaging dialog is shown.

Send Message... ok Send Message... ok
To:[a.wojicinski@tracerplus.com | To:| 14885556966 |
Report:[Message_Sample.rpt [*] |Report:[inspect_alert.rpt ]
O Al records — O Al records —
(O Current record ' (@) Current record '
(@ Where: — () Where: —
[Order # 7| = [Condition = =
1123123 [ [Needs Repair [
Status: Preparing Message Status: Preparing Message
[Concel | [ send ]
Email Report Text Alert

This dialog allows you to select specific records to send via email or text message. The options
include all records, current record or use a filter to choose a range. To set a filter:

3. Select the field to filter on from the drop down.

4. Enter filter criteria.

Note: The Message Prompt Dialog box is not editable when the “Send Message Automatically”
option is chosen in TracerPlus Desktop and will only appear momentarily .
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Chapter 4: Managing Data
4.1 Transferring Data from the PDA to the PC

Portable Technology Solutions provides a number of ways to transfer data collected in the field
to a back-end database system. The Three most popular, and efficient methods; TracerPlus
ODBC Link, TracerPlus Wireless Server and TracerPlus Connect for Microsoft Excel provide ways
to sync data between mobile devices and host databases automatically and with consistent
accurate results. However, it is also possible to transfer data between the PC and PDA manually
via import and export commands available from the PDA menu options. This section outlines all
of the features available for manual PC processing.

4.1.1 How Data Can Be Sent Manually to the PC

TracerPlus transfers all session data to the PC via standard import/export options. Importing
and exporting allows for exchange of data between the PDA and the PC during ActiveSync.
Depending on your ActiveSync settings, the mapping to these TracerPlus generated files can be
done automatically. Before initiating the process the user must first select File->Export Data on
the PDA. Imported and Exported data is available on the PDA at \\My
Documents\TracerPlus7\Data\Exported and \\My Documents\TracerPlus7\Data\For_Import.
These links provide you access to all of your incoming and outgoing TracerPlus data. Each
session defined on the PDA generates its own independent data file. These files are
appropriately named using the session number of each given session.

You can see the session number of any given session from the Session Settings screen. Itis
important to note these session numbers prior to renaming the session and when looking for
your data. The filename for each session is Sxx_data.txt where:

XX = the session number for that session.

For example, if you have 2 sessions defined on the PDA, the first session listed would generate a
file named S01_data.txt and the second defined file generates a file named S02_data.txt.

4.1.2 Manually Importing TracerPlus Data in an MS Excel Worksheet

MS Excel allows text files to be opened directly in Excel, so for the occasional need, it is fairly
easy to open and view TracerPlus data files manually. The steps involved are outlined below.
However, if your business uses Excel as a primary database, then TracerPlus Connect for
Microsoft Excel is recommended.

In MS Excel, select File>Open.

Browse to the TracerPlus generated text file.

1
2
3. Select the file and Click Open.
4

Answer any questions regarding the type of data file as is appropriate.
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5. You should now see your TracerPlus data displayed in MS Excel in a familiar spreadsheet
format.

4.2 Syncing Data from the PC to the PDA

As mentioned above, data transfer from the database to TracerPlus enabled mobile devices in
the field has been radically simplified by the additions of TracerPlus Connect for MS

Excel, TracerPlus ODBC Link and TracerPlus Wireless Server. However, TracerPlus 7.0 continues
to include processes which allow you to send database info from the PC manually to your
TracerPlus sessions on the PDA. The following sections outline these manual processes. For
example, if an inventory control manager needs to distribute pick lists, they save the inventory
file to the \\MyDocuments\TracerPlus7\Data\For_Import folder on the PDA for later import to
TracerPlus. If a maintenance manager needs to distribute jobs, he distributes the job files to the
maintenance personnel’s \\My Documents\TracerPlus7\Data\For_Import folder.

Many of our customers connect their TracerPlus sessions with 3rd-party databases to give their
current systems added functionality. These data files can easily be created and distributed by
exporting databases from many popular databases programs.

4.2.1 Sending Session Data to the PDA

All data prepared for upload to the PDA must be copied and stored in a folder called
\For_Import. This folder must be located under the \\My Documents\TracerPlus7\Data\ folder
on the PDA. These folders are automatically created when running TracerPlus on the PDA.

TracerPlus allows tab-delimited files to be sent from the PC to the PDA. The data file must be
named exactly the same as the data generated by the Export process. So, for example, if you
want to upload data for Session 2 on the PDA, the filename must be S02_data.txt and must be
located in the \For_Import folder as described above. Once the PDA is ActiveSynced the user
simply has to select File=> Import Data on the PDA and the data will be available in TracerPlus.
Also note that appending _auto (i.e. S02_data_auto.txt) to the end of the filename causes
TracerPlus to automatically attempt an import upon next application start. This eliminates the
need for the mobile user to manually perform the File=>Import process .

The required file definition for sending session data from the PC to the PDA is as follows. <CR>
indicates a carriage-return (line break), and <tab> indicates a tab character.

Field1<tab>Field2<tab>Field3....<tab>Field9<tab>Field10<CR>
Field1<tab>Field2<tab>Field3....<tab>Field9<tab>Field10<CR>

Below is a sample data file prepared for upload to a TracerPlus session.

[ s04_Data.txt - Notepad

File Edit Format “iew Help

patal Data2 Data3 Data4d Datah Datab Data7 Datag Data® Datalld
Datall Data2l Data2l Datad4l Databl Datadl Data7l DataBl Data%9l Dataldl
DPatalll Data2ll Data3ll Datad4ll Data5ll Databdll Data7ll Data8ll Data%9ll DatalOll
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| Note: If you define data for a session number that does not exist on the PDA, it will be ignored.

Note for New Users of Windows: Some versions of Windows will not display the file extension
(e.g., “.txt”). On those systems, if you save a file as “S01_data.txt”, it will actually store the file
as “S01_data.txt.txt”. This file will not be recognized by TracerPlus. To check the actual name of
a file you’ve created, right-click on it in Windows Explorer and choose “Properties”.

4.2.2

Creating Session Data Files with Excel

To create a session data file with Excel, follow these steps.

8.

Open the file in MS Excel.

Select File from the Menu bar.

Select Save As.

In the Save As dialog box, select Save As Type: Text (Tab Delimited).

In order to avoid potential folder visibility issues within MS Excel’s Save As Dialog Box.
Save your session to your desktop as S01_data.txt., then transfer manually to the PDA.

(In addition, Session 2 should be saved as S02_data.txt, etc.)

Close the MS Excel file, then copy the saved document to the
TracerPlus7\Data\For_Import folder.

Perform a File=>Import from TracerPlus on the PDA once an ActiveSync has been
performed.

Delete the file initially saved on your Desktop to avoid future versioning problems.

Note: These files can also be saved directly from Excel to the For_Import folder located on your
Device if your copy of Excel displays your mobile device in the Save As Dialog Box.

4.2.3

Sending Drop-Down Lists to the PDA

sk DESKTOP!
{_ ~ OPTIMIZED

It is highly Recommend that drop down list be created in TracerPlus Desktop. However,
TracerPlus also allows the user to prepare and manage Drop-Down lists manually and for later
upload to the PDA running TracerPlus. The filename of list data to be uploaded must be named
SxxFyy.txt where

XX = the session number
yy = the field number
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For example, if you want to send the list contents for session 2 in the 4th field, the filename
must be named SO02F04.txt or SO2F04_auto.txt. The _auto suffix tells TracerPlus to
automatically import that file upon the next application start.

Note: Simply sending the list contents for a particular session and a particular field does not

automatically define that field as a drop down list. This must still be set in the Field Settings and
is normally configured in TracerPlus screen of the PDA application. Please refer to Chapter 6 for

instructions on setting field properties.

The format for the list files is very simple. Each list element must be stored on its own line.
Since there is only one field, there is no need for a <tab> delimiter between fields.

A sample of what this data must look like is as follows.

I S02F04.txt - Notepad =3
File Edit Format WView Help

Apples
oranges
Pears
Grapes

To Import drop down data including filter values, use a tab delimited text file with two
columns. The first column is used as the display value, while the second column is the filter
value. The import file name is the same as when not including the filter values.

Here is a sample of what a drop down list including filter data may look like.

B S02F04.txt - Notepad
File Edit Format WView Help

Apples  Fruit

carrots vegetable

Pears  Fruit

Green Beans vegetablg
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Chapter 5: Configuring Sessions on the Device

TracerPlus allows users to create up to 32 unique data capture programs. These unique
programs are called Sessions. Sessions are easily accessed from the View Data Screen, where
captured data can be viewed and searched. With the release of TracerPlus Desktop as a free
download, there is now very little need to configure Sessions on the device. However, in the
event that a quick change needs to be made where there is no access to a PC, having the ability
to make that change on the device can be helpful.

Note: Many of the new features introduced in TracerPlus 6.0 and 7.0 can only be configured
through TracerPlus Desktop.

:: U DESKTOP

5.1 Configuring Session Attributes _ > OPTIMIZED

The first step in creating a TracerPlus Session is to assign a name. This name is displayed in the
session menu, and is selected by the user when collecting data, editing field settings, or editing
session settings. To create a Session name, follow the steps below.

— 1. From the launcher screen, select the Configure tab.

2. Select Session Settings.
3. Check the Enabled checkbox

4. Enter the name of the session you are creating.

5. Configure your session’s General, ActiveSync, Data and Misc. attributes. These
are described in detail in Section 5.2. When you are finished, press the Done
button. If you do not need to modify the session, the default settings are used
and you can proceed directly to Chapter 6 - Field Settings.

\ 4

Configure | Data Entry | View Data |

<
<«

ActiveSync
I¥isc

i) A ¢
Session Field Printers .
Settings Settings Start On Fisld: m

E.\) _g%;; Start On Screen:
;\gﬁilﬁéss Passwords Key Figld:
[] Ediit on Scan/Find in grid
(] Ediit on Click in Grid

Last Sync: nfa

File Dptions Admin Help Q File Options Admin Help
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5.2 Session Settings Explained BT PKToR

5.2.1 General Session Settings

General Session Settings are used to control the general operating characteristics of the session.

AckiveSync
Misc

Start On Field:
Start On Screen:

[] Edit on ScanfFind in grid
[] Edit an Click in Grid

File Options Admin Help

Start On Screen
Select the screen the user will enter when first start TracerPlus. The user can choose between
starting on the View Data Screen, Data Entry or the (default) Launcher screen.

Note: This option only takes effect when this session was the last one used; each session has its
own settings.

Start On Field

Select the first field the user is focused on when New is selected from the data view screen.
This setting is commonly selected to control what data must be entered when the program is
initially opened.

Example: A session is created to capture package delivery information. Date and Time stamps
are captured in fields 1 and 2. The bar-coded Package ID will be entered into Field 3. In this
scenario the Start On is set to Field 3 since Field 1 and 2 are entered via automatic date and time
stamps.

Key Field
The Key Field is used as the index field for the TracerPlus session data. This enables increased
speed in searching TracerPlus records. Select the field most used for searching.
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Edit on scan/Find in grid
Select Edit on scan/Find in grid to automatically open records in the data entry screen when a
record is located using ‘Find’ or scanning on the View Data screen.

Note: The field selected from the Find drop down menu, located in the Data View Screen,
defines the field that is being searched.

Example: A session is created to perform an inventory audit. The goal of the audit is to quickly
find items in the TracerPlus database and compare the database values to the actual inventory
levels. To speed this process, the Edit on scan/Find in grid setting is enabled. When an item is
scanned in the find field and located in the database, the matching record is automatically
brought up in the data entry screen for editing.

Edit on Click in Grid

A similar option for automatically editing a record is the behavior of editing a record
immediately upon clicking it in the grid. Selecting this option is very useful for the user who is
performing a lot of edits to existing data.

Note: When this option is selected, it is not possible to delete a single selected record from the
grid. The user must turn this option off before being able to delete single records. The Delete
All menu choice behavior is not affected.

5.2.2 ActiveSync Settings (Windows Mobile Device Center in Windows Vista)

Import/Export settings are used to control how data is moved from your PDA to PC when not
using TracerPlus ODBC Link software.

[Jame:
|Imrentor3t

Enahled

General

- Data

[] Delete Data After Expart
Archive PC Data after Import

File Options Admin Help

Delete Data After Export

Select Delete Data After Export if the data should be removed from the PDA database after a
successful export. Note that if data is not successfully exported, as a safety precaution, it will
not be deleted from the PDA Database even when this option is enabled.
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Archive PC Data After Import

Select Archive PC Data After Import if you wish to archive any files imported to the PDA during
an import. Any data files imported to the PDA are renamed with a prefix of “old_"” on the PC
after a successful import if this option is selected. Import files include both list contents as well
as any session data needing import to the PDA.

Note: Without this option, your upload files will be uploaded every time you perform an import,
which may cause the import process to take longer than necessary.

Use Custom ActiveSync Folder
Not Available in this version.

5.2.3 Data Storage and Transfer Settings

Data settings are used to control the format of the session’s data file exported via File->Export.

Itemn List |5 |Invent|:|r\,f
Session 03

Session 04
Session 03 Ackivesync
Sess!un )] lisc

Export 2s: |Text, Tab Delmited =
tppend To Existing

Send Mon Visible Fields

[] Include Figld Mames

File Options Admin Help

Export As
This option allows the user to select from one of six possible data formatting types

Text (Tab delimited)
This formatting option embeds a <tab> character between every transferred field. Each
record is terminated with a Carriage Return/Line Feed (CRLF)

Text (Comma delimited)

This formatting option wraps each field in quotation marks and separates each field with a
comma. Each record is terminated with CRLF.
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Text (Fixed Width)

This formatting option transfers all fields using a fixed width. Any space remaining at the
end of Field data is padded with spaces. Use of the Max Length field setting is also used to
dictate the width of each fixed width field. The maximum length of any given field is 64
chars. Each record is terminated with CRLF.

XML
This formatting option allows data to be transferred in XML format. This is very useful for
customers when importing into existing systems.

HTML
This formatting option transfers all data in HTML table formats. This provides a formatted
representation of the collected data that can be viewed as a web page.

This formatting option separates each field with a comma. Each record is terminated with
CRLF.

Append to Existing File

By default, TracerPlus appends new data to any existing data file in the \Exported folder located
on the mobile device. When this option is selected, the new data file is added to the pre-
existing file if it exists. If this option is not selected, any previously transferred data is deleted
and a new file is created on each export operation. A new file is created if it does not exist
regardless of this setting.

Send Non-Visible Fields

By default, TracerPlus does include non-visible fields in the data file. When this option is
selected, non-visible fields will be sent to the export file. Refer to Chapter 6 on how you might
use this option.

Include Field Names

By default, TracerPlus does not include field names in the export data file. When this option is
enabled, the user configured field names are provided in the generated data file. Depending on
the file format, this is represented in different ways. For all of the text data transfers, the field
names are included as a header record, being transferred as the first line of the data file. For
the XML and HTML formats, the field names are included in the general formatting of the data
file.
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5.2.4 Miscellaneous Settings

These setting are used to change the behavior of the session’s data table filtering.

Irventory [arne;

ISte'T! LiStD3 =] [rventory |
ession 03 [
Session 04 Enabled

Session 05 General ActiveSyvnc
Session 06

[] Retain filter during entry

File Options Admin Help

Retain filter during entry

Use this option to set the state of the current filter when entering the entry form. When the
data table is filtered and the “Retain filter during entry” option is selected, the current filter is
applied when in the entry form. This option also affects the auto find on scan option. When a
filter is retained, the entry form can only be used to find data that matches the currently
selected filter. The record count also reflects the filtered record count.

. . . . ] < DESKTOP
5.3 Deploying Configured Sessions to Multiple Users L= OPTIMIZED

Please refer to Chapter 9 Section 9.3 for a detailed look into how to deploy session
configuration to your entire workforce.

e

A=} Tip: An easy way to reset a session to defaults is to disable and re-enable the desired
session. In the Session Settings form, select the session you would like to reset. Uncheck the
Enabled checkbox. A prompt is displayed asking if you would like to restore the session to
defaults. Simply select Yes and re-enable the session to restore the default settings.
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Chapter 6: Configuring Field Settings on the Device

As with Session Settings, the procedure for configuring Field Settings has been simplified greatly
with TracerPlus Desktop. In addition some of the newer features now available in TracerPlus 7.0
can only be selected and configured from within TracerPlus Desktop. After a session is created,
fields within that session may also require configuration. Before configuration, all available
fields within the session are in a default state. TracerPlus Standard has 10 fields available for
configuration and TracerPlus Professional has 50 available fields.

Customizing your session settings and field settings is not required, as the default settings will
work perfectly for many users. However, to fully realize the power of TracerPlus, some of these
settings may need modification for your specific needs. Proper field configuration speeds up
data acquisition and help to prevent data input errors. Again this depends on your specific
collection requirements.

In this chapter, you will learn how to set up fields for your specific application. Section 6.3
explains the various TracerPlus field settings in more detail. Each Field Setting is also described
in detail in the TracerPlus Desktop manual.

6.1  Configuring Field Settings = |Rua¥zTiiss

Below we go through the steps required to configure field settings.

1. From the TracerPlus Launcher Screen, select the Configure tab. 2. Select Field Settings.
PTS TracerPlus @ @ Y ¢ & 6:47

TrRcsiPlus
Configure | Data Entrv|View Data

\ 4

T | B
Session Field Printers
Settings Settings
G 8
Wireless Passwords
Settings

Last Sync: nfa

File Options Admin Help i A
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Chapter 6: Configuring Field Settings on the Device

3. Select a TracerPlus session.

PTS TracerPlus

4. Select a field to configure.

v

B Vehicle Inpection (v

Type: [Text (=]

Yalidation

Field 2
Field 3
Field 4
Field 5
Field 6
Field 7

General

After Scan | Drop-Down

Data Type: [Date/Time (=]

Default:

Visible Show in Grid
I:l Use Popup I:l Read Only
[] Lookup

P & Y@ 60

File Options Admin Help |

PTS TracerPlus

Vehicle Inpection =]

L)

Q @ Y, € @ 6:50

5. Enter the field Name.

Type:
General WYalidation
Drop-Down

|.ﬁﬂnr Scan |
Data Type: [Date/Time I~

Default:

Visible Show in Grid
D Use Popup D Read Only
[ Lookup

Name: | %

File Options Admin Help m (]|
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Chapter 6: Configuring Field Settings on the Device

6. Select a Field Type. Section 6.2 discusses these field types in more detail.

PTS TracerPlus

T &Y, @ 650

Vehicle Inpection =

Ll

Field 2
Field 3 Name:

Field 4

et
Field &
Field 7

Checkbo

Variable
Data Type: |Datefsignature

Calculated
Default: F‘"""“'ﬂ]mage

Visible Show in Grid
[Juse Popup [ ] Read Only
D Lookup

File Options Admin Help [g8 i

7. Enter General field settings. Section 6.2.2 discusses these settings in more detail.

PTS TracerPlus ' @+ Y, 4 @ 6:52

P [Vehicle Inpection =]

Type: [

Yalidation
After Scan | |Drop-Down

Data Type: [Date/Time [=]]

Default:
Visible Show in Grid
[]use Popup [] Read only

D Lookup

File Options Admin Help g8 1

Field 2
Fiald 3
Field 4
Field 5
Field &
Field 7

8. Enter additional field settings. Refer to Sections 6.2.3 through 6.2.5 for more detail on the
other available field settings options.

9. Repeat steps 4 through 8 to configure additional fields.
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6.2  Field Types 1

The Field Type setting is used to control what type of data is entered for this field. TracerPlus
has seven available field types outlined below.

Note: Previous versions included Data Lookup functionality as a Field Type. In version 7.0, this
has been upgraded to a Field Setting (see Section 6.3.4). This provides expanded capabilities by
allowing lookups on the various Field Types.

Field 2 | =
Feld 4| 1ype: Fran ) Field Type Standard | Professional
Field & Text v v

Ficld 7 Drop-Down

Eiald 2 ARter|Checkbox Drop-Down v v

Wariable
Data Type: |Datefsignature Checkbox v v
. Calculated

Deraut: | Formatimage Variable v v

Visible Show in Grid -

|:|Use Popup DRead Only Slgnature X v

] Lookup Calculated X v
Image X v

File Options Admin Help [78 o
6.2.1 Text

Text fields should be chosen when data is to be entered via a bar code, keyboard, or graffiti The
Text type does not restrict input in any way, and can store up to 64 characters.

6.2.2 Drop-Down

Drop-Down fields allow the user to select from a pre-defined list of items. Drop-Down fields
offer a quick, error free way to enter data from a select list of choices. Section 6.2.5 provides
more detailed information regarding drop down lists.

6.2.3 Check Box

Check box fields are used when simple Yes/No, True/False, On/Off selections are made. Check
boxes should be used whenever possible to speed data entry and limit data entry error.

6.2.4 Variable

Variable fields are used to automatically enter values such as User or Auto Number field. To set
a Variable field the user selects the value they would like to enter in the field from the drop
down menu. The selected setting will then appear in the “Default” field value in the Settings
screen. By default, Variable field values are populated when the record is first created. To
update the variable each time it is submitted, simply enable the Update Value option for that
field. Refer to Section 6.2.4 for more information regarding Update Value.
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: éession 01 v—|

P | e

Field & p—— —
Field 7 Genetral Walidation
Fields || [After Scan | [Brap-Down
Data Type: |General 7]
Defait: (| H
visibleE:;ﬁgﬁ]m

[ Use A[*&UTOMNUMBER: 1,1%]

[*IMPUTTYPE:1*]

Done |

File Options Admin Help O

USER
When USER is selected the field is automatically filled with the PDA ID of the device. If
utilizing User Logins this field will be populated with the logged in user name.

INCR:1,1

When INCR:1,1 is selected, the field is set to be an auto-incrementing field. The first digit
represents the starting value while the second digit represents the increment value. The
default setting INCR:1,1 starts the record as a value of 1 and increment by 1 for every
following scan of a previously scanned bar code. This feature can automate a lot of data
entry tasks that involve counting items.

This field setting option is dependent on the Auto Find on Scan Field setting. Refer to the
appropriate Session and Field settings section of this manual for more information in this
area.

The INCR variable type can also be used to count backwards by setting the second number
to a negative value.

AUTONUMBER:1,1

The AUTONUMBER variable type is used as an auto incrementing value that
increments on each submit irrespective of any field data. This value can be started at
different values by changing the number directly following the colon. It may also be
incremented by the value specified after the comma. The default is to start at one and
increment by one.

NOTE: Resetting the AUTONUMBER value

To change or reset the current AUTONUMBER value the session configuration file must be
modified. To do this open the corresponding session configuration file in a text editor, this
file can be found in the System folder of the PDA. In the AUTONUMBER field which needs
to be modified look for the autonumber="" attribute and change to the value required.
Save the file and copy back over to the System directory on the handheld.
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INPUTTYPE

The INPUTTYPE variable is used to display the method of data entry in a particular
field. The method of entry can be keyboard input or a barcode scan. If the method
of entry was a barcode scan the INPUTTYPE field will be populated with the type of
barcode that was scanned. To configure an INPUTTYPE field simply select the
INPUTTYPE variable from the drop down and enter the field needed to capture the
input type. As an example, if the variable setting for Field 2 is “INPUTTYPE: 5”, Field
2 data will contain information about how data for Field 5 was entered.

6.2.5 Signature (Professional Version Only)

When a field is specified as a Signature field, a popup is displayed when the user selects this
field in the Entry screen. This popup can then be signed and when the user clicks Done the
signature is saved in the database. When a session is exported signatures are stored in a
separate subfolder \Exported\Bin. Note: When a signature has been entered the field

says “-- Signature exists --” and the signature is not saved until the user submits the record

in the Entry screen.

PTS TracerPlus [ @+ Y, «: @ 7:12

WVehicke Inpection |=]

Ll

Field 2 [

Field 4 5

Feds | Tvee: N =]
Field &

VYalidation
After Scan | [Drop-Down

Field 7

Data Type: |General e Sign Here T

Default: Technician Signature

[v] Visible

[] Read Only o -,/é
r-"ﬁ_,/f_’ i Lani

|:| Lookup _ / i
gy )

File Options Admin Help 33 | Done || cancel || Clear |
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6.2.6 Calculated (Professional Version Only)

A Calculated field is used to perform simple mathematical operations between fields and
with constant values, string concatenations, and field data parsing. This is useful for
invoicing or mobile receipt printing. With calculated fields you can add, subtract, multiply or
divide two fields, or perform these operations with a numerical constant such as tax or
discounts. It is also possible to use the Left, Mid and Right parse functions to extract field
data based on defined Start and Stop points.

Note: Calculation functions have been expanded and the configuration simplified. However,
these additional abilities can only be accessed through TracerPlus Desktop.

Configuring a Calculated Field
— 1. Select the field you would like to configure.

2. Select Calculated from the Type drop down.

3. Then click on Calcs in the General Field Settings.

4. The Calculated Field Options dialog box is shown.

PTS TracerPlus [ @+ Y, & @ 7:13

P [Vehicke Inpection x
Field 2 @8

Field 4 Type: [CET RN

—p [Field 5 <
E'E:g 3 Yalidation
i
e o After Scan | |Drop-Down
Data Type: |General *|
Default: <
Visible [] show in Grid
[w] Use Popup []Read Cnly
|:| Lookup

File Options Admin Help i
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Calculated Field Options dialog

Calculated Field Options -
Function:|* |
oprfgy ¥l Constant
Op 2:@5 Constant

~Farmat options

Currency

Cecimal places: E

Function
The Function drop down is used to select the operation to be performed for the
calculated field.

Basic Functions

(+) — Depending on the field’s data type the addition operator will add
the 2 operands together. A string concatenation will be performed if
the data type of the selected field is General. If the field’s data type

is Number, a mathematical addition operation will be performed.

(-) — The subtract operator will subtract operand 2 from operand 1. This
operation is only available for a field data type of number.

(*) — The multiplication operator will multiply the two operands. This
operation is only available for a field data type of number.

(/) — The division operator will divide operand 1 by operand 2. This
operation is only available for a field data type of number.

Min — The Min operation is used to select the minimum value between 2
operands. For example, operand 1 is 10 and operand 2 is 5 the
configured calculated field will contain the value 5 when the

operation is complete.

Max — The Max operation takes the maximum value between two
operands.

LEFT— See advanced functions below.

MID — See advanced functions below.
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RIGHT — See advanced functions below.
GPS_LATITUDE — See advanced functions below.
GPS_LONGITUDE — See advanced

Op1l

From the Op 1 drop down select the field you would like as the first Operand in the
calculation. You can also select Constant. This allows you to enter an alpha-numeric
value in place of a field.

Op 2
From the Op 2 drop down select the second Operand in the calculation or select
Constant to enter a constant value.

Constant
When Constant is selected the Operand selector becomes a text box and allows you
to enter the alpha-numeric constant to be used in the calculation.

Format Options

The format options allow you to format the result from the calculation in a number
of ways. Select Currency to add a dollar symbol ($) to the beginning of the string.
The decimal places allow you to change the number of decimal places displayed.
This can range from zero to six.

Advanced Functions

LEFT - The LEFT function is used to extract or parse field data from the
beginning of the string to the Stop value.

MID -  The MID function is used to extract field data from the defined Start
point to the defined Stop point.

RIGHT—  The RIGHT function is used to extract field data starting at the right
side of the string to the defined Stop point.

NOTE: When selecting a LEFT, MID, or RIGHT function the Calculated Field Options dialog will
change to accommodate the new options. The dialog is shown below.
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Function: |MID - |

Saurce: |Field1 -

-Parse settings

Start

Type: valLe: OCCurence:
[cHar  ~|[P MIFE
Stop:

Type: talue:

[NDEX =[5 |

Source

The Source is the field that will contain the string to be parsed. For example,
the user would like to extract the first 5 characters from a barcode scanned
into the first field. The source would then be Field1.

Parse settings

Within the Parse settings group box the options for LEFT, MID, and RIGHT
will appear. These options include a Start and a Stop point. For the LEFT and
RIGHT functions only a Stop point is configurable since the Start point is at
the beginning and end of the string respectively. For a MID parse the user
must specify both points.

Start
A Start point is available when a MID function is selected. The Start point
defines where the parse is to begin.

Stop
The Stop point defines the point at which the parse should end.

Type

There are two available types, INDEX, and CHAR. An INDEX type is used to
define a specific index or length of a resulting string. A CHAR is used to
match a character or ASCII value.

Value

The value is the defined delimiter. When it is of type INDEX an integer value
is required in the value field. For a Start point the value specifies the index
in the string where the parse should start. For a Stop point of type INDEX
the value specifies how many characters to include. When a delimiter is of
type CHAR any valid character delimiter can be used, this includes ASCII
characters in HEX notation.

Occurrence
The Occurrence field is only available for delimiters of type CHAR. The
Occurrence option is useful if the string to be parsed contains multiple
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instances of the same delimiter. For example, the barcode being scanned
has three fields of data separated by the tab character, and the user would
like only the middle field. To extract this value, two CHAR Start and Stop
points should be defined. The Start point will be the First tab character and
the Stop point will be the second tab character. So, for the Start point the
occurrence will be one and for the Stop point the occurrence should be set
to two.

GPS_LATITUDE

When selecting the GPS_LATITUDE function the selected field will be populated
with the devices current latitude. This function requires a supported GPS device
connected to the PDA. (Section 1.6)

GPS_LONGITUDE

The GPS_LONGITUDE function will populate the selected field with the devices
current longitude. This function requires a supported GPS device connected to
the PDA. (Section 1.6)

Note: The data type of a calculated field is important. If the data type is set as
general the only available functions are (+), LEFT, MID, or RIGHT. The (+)
function will perform a string concatenation between the two operands if the
data type is set to String. If the data type is Number the specified
mathematical operation is performed on the two operands.
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6.2.7 Image (Professional version only)

When a field is selected as an Image field type, the user can capture camera images for a given
data collection record. This is only supported on devices running Windows Mobile 5.0 and
greater. Of course, the PDA must also have a digital camera installed. When selecting this field
type, your data entry form displays a button allowing the user to launch the camera dialog. This
dialog allows you to view a previously taken picture or capture a new one. Once captured, this
image is stored against the current record. When exporting, this image is exported to the data

folder under a subfolder called \Exported\Bin.

To configure a field for image capture, select the field you would like to configure, select Image
from the Type drop down, then click Done.

PTS TracerPlus '@ @:& Yt o 3 6:37
Photo 2

| PTS TracerPlus “i @'—_i Y( of: & 6:35

WVehicle Inpection

Jimage [T
m Vo]
ter Scan | [Drop-Down
Data Type: |General =
Default:
Visible
[] Read Only

] Leckup - =
= () ()

.

Fle Options Admin Help P F = OK
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6.3 Field Settings }

Once Field Types have been determined, additional attributes need to be assigned to each field.

6.3.1 General Field Settings
General Field Settings allow the user to define the most basic field attributes. These settings
allow a TracerPlus user to remove visibility of a field, establish default values, numeric only

fields, and read only fields.

Data Type

The Data Type represents the format of the expected data for the selected field.

PTS TracerPlus (1)) @+ Y, ¢ & 7:19

P [Vehicle Inpection .
Field 2 |8
Field 4 0
et e e
Field & Validation
Field 7 [ &
e ter Scan | [Drop-Down
Data Type: | =|
Default: |
[w] Visible (] Show in Grid
[w] Use Popup [ ] Read Cnly
[ Lookup
file Options Admin Help F33 i
General

General is set to accept all data types in a field.

Number

Number is set when the field is only used for numeric data. When a field’s Data Type is set

to Number, it does not accept any Alpha characters.

Date/Time

The Date/Time format is used to enter formatted Date and Time values. These formats are

configurable using the date time format configuration screen. The default format is the
user’s system default.
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Configuring a Date Time Format
The system default is used as the default time format. However, it is possible to change

this format to any type the user requires.

1. Select Date/Time from the Data Type drop down.
2. Click on the Format button which appears.

PTS TracerPlus

M@ Y, & 718

el

Field 7

Vehicle Inpection 1|

Field 2
Fedd  |wefor
Field &

‘Validation
After Scan | |Drop-Down

Data Type: &)
Default: | Format |g

[] visible [] Show in Grid
Use Popup [] Read Only
|:| Lookup

File Opions Admin Help oY |

Date Time Format Configuration Screen

After the Format button has been pressed the Format configuration screen is
displayed. From this screen the user can configure a preset list of formats or create
their own using the Current Date/Time Format edit box.

PTS TracerPlus i' (_i:_s '\_I'; o 3 641

Current Date/Time Format
|M,.rdd,rw hemm:ss t"M™ ]
Sample: 3f08/11 6:41:07 PM

~Select date format
[Fa/dd vy =]

~Select time format

Use GMT Date/Time [_]

Done || Cancel |

file Options Admin Help [{lf

Current Date/Time Format
From this field the user can enter the format desired by entering valid Date/Time

format characters. These characters are described in detail in Appendix Al.

Clear
Use the Clear button to remove the currently set format.
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Select date format
This list contains pre-configured date/time formats. Select one from the list and it
will be added to the Current Date/Time Format string.

Select time format
This list contains pre-configured time formats. Select one from the list and it will be
added to the Current Date/Time Format string.

Use GMT Date/Time
Select Use GMT (Greenwich Mean Time) Date/Time to display the current GMT
Time in the current user selected format.

Done
Press the Done button to save the format string and return to the Field Settings.

Cancel
Return to the Field Settings form without saving.

Default
The Default represents the value that is initially used for the selected field. For example, you

may set up one of your fields to represent a quantity. Likewise, you might want to set the
Default for that field to be 1.

Note: If the user clicks the Clear All button from the data entry screen, this default value is
cleared, as well.

Default values can also be entered using Variable field settings. Refer to Section 6.2.1 for more
information.

Visible

This option is normally selected and allows a field to be viewed or hidden in the data entry
screen. A field’s visibility should be turned off when it is not being used in a session or if the
default contents need to be stored but not seen by the user as in some cases of Date/Time
stamping of an individual record.

Show in Grid

When Show in Grid is selected, the field is visible in the View Data Screen grid. Fields are
displayed in their numeric order in the grid.
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Use Popup

This option is only valid when the Data Type for a field supports it. Currently only Date and
Numeric data/field types allow for the optional pop-up dialogs. This option is ignored in all other
data type settings. When a valid field is tapped with this option selected, a popup dialog
appears. Below the two different popup types are explained.

Numeric Popup Dialog (Professional Version Only)

The Numeric Popup Dialog works like a calculator. When a valid field is tapped the
current numeric value in that field is placed in the calculator. The user can then do
simple math calculations on that value. When Done is pressed the value is entered into
the corresponding field in the Entry screen.

|
TP EEE
]
nanE
onaniy

+10
-10
+1
-1

C

CE
Done

Cancel :

Numeric Popup Dialog Button Definitions

Adds 10 to the current value

Subtracts 10 from the current value

Adds 1 to the current value

Subtracts 1 from the current value

Clears the value

Reverts the value back to the original, when the Popup first came up
Performs any final calculations and returns the user to the Entry screen
Returns the user to the Entry screen and reverts value back to original
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Date Time Popup Dialog (Professional Version Only)
The Date Time popup is used to select dates and times from a calendar and time picker.
These values can be formatted to any locale using the date time format options.

DakelTime

[2i032005 3:31:50 am

31s =]
2:31:50 &M =

KB February 2005 I3
S5 M T W TF S

1 z[El 4 5
€ 7 8 9 10 11 12
13 14 15 16 17 15 19
20 21 2z 23 24 5 %
27 28

| Done || Cancell | Mo |

Read Only

When the Read Only option is selected, the user does not have the ability to enter data in the
selected field. This is commonly used in conjunction with default values and Variable type fields.

Lookup (Professional Version Only)

Note: Beginning with TracerPlus version 7.0, the lookup configuration has been moved to Field
Settings. As a result, lookup capabilities can be performed on most of the Field Types described
above in section 6.2. Only the Variable Field Type is exempt since the purposes of that type do

not mesh with the need to lookup comparative data.

A Lookup field is populated with data from another session (source). When properly
configured, a Lookup field matches the defined relationships between the current session
and the source session. If that record is found in the lookup session, the assigned field data
is populated in the current session’s assigned field. As an example, this could be a customer
name based on an entered customer number, or a part description based on an entered
part number.

To configure field Lookup capabilities, enable the Lookup checkbox on the General Setting
screen.
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PTS TracerPlus [T @ "‘T:: of: (2 10:37
Field 34 PN [vehicle Inpection =]

Field 35
Field 36 __jName:

Field 37
Field 38
Il [
After Scan | |Drop-Down

Field 39
Dota Tpe:

Default:
[w] visible how in Grid
Jse Popup [ Read Only
———— [ ookr —

File Opticns Admin Help g3

2. Then configure the following settings.

Lookup Settings

Lookup
~Source ~Source
Session: [Vehicle Inpection  [=] Session: |Vehicle Inpection |7
Field: [Tire Wear/Condition [=] Field: |Tire Wear/Condition =]
Options
~Lookup Relationship ~Lookup Relationships——
Local Fields  Remote Fields Local Fields  Remote Fields
Name: Name MName ame
Trigger Field: Trigger Field:
[ Cance | Done |
Source
The source section is where the user defines the data required from the lookup
session.
Session

Select the session from where you would like to get data.

Field
Select the field data needed from the selected lookup session.

Options

Select Options to configure advanced settings for this lookup, the following
dialog is displayed.
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Advanced Options
Not found message:

| |

Update Source Table
Append if Not Found

Not Found Message
Configure this option to display a custom message if matching data
is not found in a lookup table.

Update Source Table

This option allows the user to update the data found in a source
table. If a successful lookup is performed any changes made to that
field update the field in the source session.

Append if Not Found

Use Append if Not Found to post a new record if the lookup is
unsuccessful. This option will post the relationship values along with
any source fields with the same relationships.

Lookup Relationships
The Lookup relationships are used to define the fields which are matched in order to
get the field data from the source session. There can be multiple fields added as
lookup relationships. For example, the user would like to grab a line item from a
session of orders. To do the lookup the relationships should be defined to match the
order number and the line item required.

~Source
Session: |[Vehicle Inpection  |=]
Field: |Tire Wear/Condition =)

=

-Lookup Relationships———
Local Fields  Remote Fields

Name

Mame

Trigger Field: [Name

Eil]l

Local Fields and Remote Fields
These list boxes show the current relationships created for this lookup. To
add or remove relationships use the buttons to the right.
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Plus (+)
Add a relationship. When selected the Add relationship dialog box (shown

below) is displayed.

Add new lookup...

Local Field: [Name

Remote Field: | ]

Local Field
The local field is the field from the current session which will be

matched against the remote field when performing the lookup.

Remote Field
The remote field is the field from the source session which will be

matched against the local field when performing the lookup.

Minus (-)
The Minus button will remove the selected relationship.

Trigger Field

The Trigger Field is the field that causes a lookup to be performed. When
there are multiple relationships set, a lookup will not be performed until a
successful scan or the down key is pressed within the Trigger Field.

6.3.2 Validation Field Settings

Validation Field Settings allow the user to exhibit controls that check the accuracy of the
entered data.

General YWalidation

After Scan | [Drop-Down

validate Immediately
Uniguein [ ] Table [ ] Recard

[] mMust Match |Part# -
[] Barcode Type |(al codes) -
Min/Max @ Length () Value

E Min:lﬂ | Ma}{:|IDD |

File Options Admin Help O
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Validate Immediately

This option represents whether or not a field should be validated immediately after it is entered.
When Validate Immediately is not selected and Validation settings do exist, the field data will
still be validated when the record is submitted.

Unique in Table

When selected, this option prevents duplicate data values within the current session. If a field is
submitted and it violates the Unique in Table setting, an audible alarm and error message is
displayed.

Unique in Record

When selected, this option prevents duplicate data values within the current record. If a field is
submitted and it violates the Unique in Record setting, an audible alarm and error message is
displayed.

Must Match

When selected, the user is prompted to select another field to match. When enabled, this
option allows the user to mandate that the value in the current field must match the selected
field exactly. If a field is submitted and it violates the Must Match setting, an audible alarm and
error message is displayed.

Barcode Type

When enabled, and a Barcode Type is selected from the drop down list, the barcode scanned in
the Entry screen must match the selected type. If a barcode type other than the one selected is
scanned, an audible alarm and error message is displayed.

Min/Max

This option can be set in one of two modes; Length or Value. When set to Length the string
length of the field will be checked using the Min and Max values described below. When set to
Value the numeric value of the field will be checked using the Min and Max values described
below.

Min

This option allows the user to validate an entry based on the minimum number of characters
required or the minimum numeric value, depending on the Min/Max mode selected. If a field is
submitted with less than the “Min” setting, an audible alarm and error message is displayed.
Setting a Min of 1, for example, prevents the user from leaving that field blank, or if in Value
mode it will prevent the user from submitted a value less than 1.

Max

This option allows the user to validate an entry based on the maximum number of characters
allowed or the maximum numeric value allowed. If a field is submitted with more than the
“Max” setting, an audible alarm and error message is displayed. Specify a Max Length of zero to
disable this rule. Fields in TracerPlus can store up to 64 characters.
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6.3.3 After Scan Field Settings

After Scan field settings are designed to increase data entry speed and accuracy. Repetitive data
capture scenarios such as inventory audits lend themselves to the efficiencies of these settings.
It is recommended that these features be activated whenever possible. ‘After Scan’ rules are
triggered by a completed bar code scan, choosing an item from a drop down list or pressing the
Down Arrow/Enter/Tab key on your PDA.

Ficld 2

ek 3 (-l
Field 4 ]

s | [
Ficld &

General “alidation
1 H After Sran Il
Auto Submit [v] Clear On Submit
[] &uta Find on Scan
(] Update Value
Go To: |Qty -

Done |

File Options Admin Help O

Auto Submit

This option represents whether or not to automatically submit this record following an 'After
Scan' event for this field. If this option is chosen for the selected field, the system automatically
submits the record and sets the focus to the field selected in the Go To prompt for the selected
field. The form is then ready for a new record.

Clear On Submit

This option is used to tell the system whether to clear the selected field after submitting the
current record in the Entry screen. If the current record is submitted as a result of an ‘After
Scan’ event or by clicking the Submit button, all the fields with this option selected are cleared.
If the field has a Default Value, that value is used instead of a blank entry. Turning off Clear On
Submit is especially useful if several records in a row will share a value for a field — it saves the
user the time of re-entering the same data when entering several new records.

Auto Find on Scan
This option allows the user to perform a lookup of entered data for this field. If the item is
found, the user is moved to this record and is placed in edit mode for this record.

Update Value

When this option is selected, Variable field data is updated to represent the variable value at the
time that the record was submitted as opposed to the default operation of using the time that
the record was created. This is really only relevant for date/time based fields and should usually
be turned off in any variable field. This is useful when you want to track the date/time a record
was edited, rather than created.
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Note: If Update Value is selected for a Lookup field the field will perform a lookup when the
record is submitted. If Update Value is selected for a Calc field the field will perform a
calculation when the record is submitted.

GoTo

This option allows the user to control the ‘tab order’ for the selected field. After a user performs
a successful scan while in the focus of the selected field, the system sets the focus to whichever
field is selected as the Go To Field. The user typically uses this feature to control the 'flow' of
data entry. Alternatively, the Down Arrow key represents an 'After Scan' event for those PDAs
that are not bar code enabled.

6.3.4 Drop-Down Lists

Drop Downs allow TracerPlus users to create their own Drop-Down list menus for specific fields.
TracerPlus gives the user the ability to create these lists either directly on the PDA or from a file
on the PC via an ActiveSync data transfer followed by a File> Import.

|Sessi0n 01 :|
Type: \Drop-Down -

General Walidakion

After Scan | [algeaEnlatyy]

Allow PC Update

[] Restrict tao List Ttems
[ sort List Ttems
[] Fitter on value from Field

File Dptions Admin Help ]

Allow PC Update

This option allows the user to create drop-down lists on the PC. During File=>Import, these lists
are loaded into the field and overwrite any existing drop-down information saved on the PDA.
For this reason, we offer the ability to disable the PC Update option. This gives the user the
ability to avoid accidentally overwriting any existing list information created on the PDA.

If you wish to allow list contents to be uploaded from the PC for a particular session and list, this
option should be checked. If you wish to prohibit the PDA from getting updated list contents
from the PC, simply uncheck this option. Chapter 4 refers to PC Operations in more detail.
Please refer to that chapter for more details regarding list updates from the PC.

Restrict to list items

This option allows you to restrict drop down selections to only items contained in the list. If this
is not selected, the user can alternatively enter 'free-form' text as a drop down item entry.
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Note: When Restrict to list items is selected ‘free form’ text is disabled. If a record is being
edited which contains field data that does not exist in the drop list, the field will be blank in the
Entry Form.

Sort List Items
Setting this option presorts the items in a list. This sort is performed as an alphanumeric
descending sort.

Sort List items
Setting this option presorts the items in a list. This is performed as an alphanumeric descending
sort.

Filter on value from Field

Select the field used to set the filter value. When a value is entered into the field selected, the
drop down being configured is filtered based on this value. For example, the user would like to
filter a drop list by location. The Filter on value from Field would be set to the location field.
Modify

Select the Modify button to directly edit the list contents on the PDA. We discuss the steps in
creating drop-down list items in the following section.

1. Select Modify. 2. Select New.
Figld: Carrier
Diisplay
Typs, Fedx
General Validation
] After Scan | (g aglalty]
Delete
Allow PC Update Modify...| <
[] Restrict ta List Items Modify
[] Sort List Items | [Pelete Al

[] Filtter an walue fram Field

A ]
| | Done |
File Options Admin Help O 1 O

3. Enter a List Item via keyboard. Click Done when finished
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4. Repeat steps 2 through 3 to add additional list items.

T 0 ¢

,}"' | PTS_ TracerPlus

Session: Session 01
Field: Carrier

Display |

.ndd,.-"Mul:lifv Items

Display Walue
[urs |

Filter Walug

J |

P
L] | Done || Cancel |

| Done |

5. If a filter for the drop down list is being used enter this value in the Filter Value field. This
Filter Value will be matched against the Filter on value from Field selected from the Drop-
Down field settings tab.

TracerPlus List Items can be edited and deleted in the TracerPlus Lists screen. Simply choose
the value to be edited and select the appropriate button.

NOTE: List ltems may also be deployed to multiple users. In most multi-user cases, the PC
update option would be used. Refer to Chapter 4 for more information regarding this powerful
feature.
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Chapter 7: TracerPlus Wireless Connectivity and Mobile Printing

71 Wireless Plug-in (Included in TracerPlus Professional) ]

To enable the wireless connectivity, an evaluation or registered version of TracerPlus Wireless
Server must be configured on the host PC.

For TracerPlus Standard users, the Wireless Plug-in must also be licensed and enabled in
TracerPlus. The TracerPlus Wireless Plug-in can be purchased with your TracerPlus license or at a

later date. users, the Wireless Plug-in is already included in with the purchase of TracerPlus
Professional.

To enable the Wireless Plug-in on your device, follow the directions below:
1. From the Launch screen, select the Configure tab and click on the Wireless Setting Icon.

G0 4¢
TrEeEiplus

Ponfigure |Data Entry | view Data |

" i) =)
Session Fild Printers
Settings Settings
O <%
Wireless Passwords
Settings

Last Sync: nfa
File Options Admin Help O

2. Check Enabled.

3. Enter the Server host and Port to be used for the connection.

Inventory
[tern List

Enabled

Haost Address: [192,158.4.107
Port: |4402

P& MickMarne

A

|Y0ur PDA Mame |

=]
- " - [
File Dptions Admin Help (@)
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7.2 Mobile Printing

1. From the Launch screen click on the Configure tab.

fr 0 4

TrReEiPius
Configure | Data Entry | view Data |

" T
Session Field Printers
Settings Settings

& %
Wireless Passwiords
Settings

Last Sync: nfa
File Options Admin Help O

2. Select the Printers icon.
3. Check Enabled.
4. Select the printer you want to use from the drop down list.

5. Select the report you want to use from the drop down list.
Note: The report is the format you would like to print in. You can select one of the pre-
configured reports that come with TracerPlus, or you can create your own. Please refer
to the TracerPlus print format manual for more information.

6. Select the default print option when you select File=>Print. This includes All records,
Current record, or Prompt for filter.

Start Print Automatically
Select this if you would like TracerPlus to print automatically when you select File=>Print.

Auto Print on Submit
This option allows you to print automatically when a record is submitted in the entry screen.

Test Print

Press this to test printer settings. This is the only option available when TracerPlus has not
been registered for the Print Plug-in.

Options

Use the Options button to configure the connection settings for the selected printer.
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& T s

Wireless) ST

Iter List

Enahled
Printer:
|Zebra QL series v| | Options |
Report: |Imrent|:|r\,r.rpt v|
Print What: |Current Recaord -]

[] start print automaticaly
[] &uta print on submit

File Dptions Admin Help

Print Options Dialog
To configure the printer select the Options button. The following dialog will be displayed.

Mame: |Zebra L series |
-Connection Settings

Comm Type:
Baud:
Part:
Parity:
Data Bits:
Stop Bits:

The Print Options dialog allows you to select how the printer is connected to the handheld.
Available options are RS232, and TCP/IP.

To configure a cabled connection (R$232):
1. Select RS232 from the Comm Type drop down.
2. Select the appropriate settings for your handheld and connected printer.

Another available option is a TCP/IP connection to the printer. Using a wireless handheld with
TracerPlus and a networked printer you can print wirelessly using TracerPlus.

To configure a TCP/IP connection:

TracerPlus 7 for Windows Mobile/CE 59



1. Select TCP/IP from the Comm Type drop down.
2. The following options will then be displayed.

Options

Marme: |Zebra L series |
r Connection Settings

Comm Type: |TCRSIP -

Host IR |192.165.4.12
Host Port: {o100]

3. Enter the Host IP address, and Host Port of the printer.
4. If all settings are correct, TracerPlus will now print to the configured network printer.

Note: For More information on Custom Print Reports, See the TracerPlus Print Guide
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One of the more impressive abilities of TracerPlus Desktop is the intuitive drag and drop Form
Designer. Developed to mimic tools and actions found in many graphics programs, the Desktop

Form Designer offers clear advantages in both ease of use and access to new TracerPlus
features. For this reason, using the TracerPlus Desktop Form Designer is the obvious choice.
However, functionality for creating custom forms on the PDA remains for legacy users.

8.1 TracerPlus Entry Skins

TracerPlus continues to offer users the ability to create custom forms on the PDA. Now utilizing
the power of the Entry Skins advanced users can completely customize the look and feel of their

forms. Allowing users the ability to speed data collection and organize data fields. A default
Entry skin is located in the TracerPlus Skins folder on the handheld. Below is a screen shot of a

customized Entry Skin.

r

i /g |PTS TracerPlus ot o< 207
Boiler Test Records: 1

I [10-010207

[Read IChems ] Cond | Job |Cust I Sys

Service Tech ID |02662400-00410255

Time In [4:06:17 AM

Time Out [4:06:17 &M

Service Date |1Jf|j?f2004

Systemn Status |OI<

# of Systems Insp |5

Cust Signature |- Signaturs Exists -

File Options Admin Help

E|A

r

i iy |PTS TracerPlus gl EEH L
Boiler Test Records: 1
I |10-010207

IReadl Chermns |C0nd | Job ICust Sys

8.1.1 Entry Skin Configuration

Added  LIOM Left Lz
Inh |5 ||Gal. v||2 ||Gal. v|
Chemz [1 |[rt. «|[12 |[t. ]
crems f_ e ][]
File Options Admin Help [

The Entry Skin is configured using an XML file. This XML file contains coordinates for all

the fields, labels, and tab controls if being used. The skins file is name in the following
format Sxx_entryskin.tsc, where xx is the session number, and is located in the Skins

folder.
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Starting tag of a block of controls (Controls include fields, labels,

<controls> and buttons).
<control> Use the control tag to define a new form control.
o left Left side control
e width Sets the width of the control.
e top Use to set the top of the control.
¢ height Sets the height of the control.

e controlindex

Each control should be listed with an index, starting from 0 to the
last control. This is used as an identifier for alignment.

¢ laligncontrolindex

the lalign attribute is used to align the left side of a control to the
index set for the attribute.

 type Defines the type of form control to draw.
DB The DB type is a database entry control, such as a field or a drop
down. The type is defined in the Field Settings.
e STATIC Creates a static label control.
e BUTTON Creates an entry control button

¢ BITMAPBUTTON

A button control that can display a user defined image as the
button.

<options> Extra options specific to the control type.
« caption When the label is set to type STATIC, if a caption is present this
will be the value of the label.
The align attribute is used for a STATIC type control. This will set
e align the text alignment for the label. Possible values include left,

center and right.

e dbsourceindex

The dbsourceindex attribute is used to associate a control with a
particular field in TracerPlus. For instance, the first control is used
to input data into Field1 in TracerPlus, the source index would be
setto 0.

A button type control can perform different actions when clicked.
To define an action use the action attribute. Possible values

* action include: 0 (submit), 1 (Done), 2 (Clear All), 5 (Return to the
launcher screen), 6 (Print).
The buttonup attribute is used for BITMAPBUTTON control types.
¢ buttonup Use the buttonup attribute to set the bitmap filename of the

button when in a non clicked state.

e buttondown

The buttondown attribute is used to define the bitmap filename
when a user clicks the selected BITMAPBUTTON control.

<pagecontrol>

Opening tag of a Page control.

o left Left side of the page control
e width Sets the width of the page control.
e top Use to set the top of the page control.
¢ height Sets the height of the page control.
<pages> Starting tag of a group of pages
<page> Creates a new page on the page control. A page can contain a
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group of controls.

The name attribute adds the title for the page. This title is added

e caption
P to the tab on the page control.

Each page must contain a valid index. The index starts at 0 and

¢ pageindex .
Pag increments for each page created.

8.2 TracerPlus Session Launch Screen

&

¢ iy |PTS TracerPlus &3 g 448 9

JIZIS2NE=UsS
Lot Tracking | asset Track | Route [ 4] »
Incuct Rasw Create FG Pick and
Material Lot Pack
Wiewy Faw
Material
File Options Admin Help E|A

The TracerPlus Session Launch screen is used to easily navigate TracerPlus sessions and allows
easy data entry and data viewing. Although a default launcher file is created automatically in
TracerPlus, the option is available to customize the launcher to group sessions to form an
organized menu of applications. To reconfigure the launch screen, a Launcher.tsc file must be
created and placed in the \My Documents\TracerPlus7\Systeminfo\Skins folder on the PDA.
This file can easily be created in Notepad or other text editing programs.

8.2.1 Launcher Configuration
To configure the TracerPlus Session Launch screen an XML file named Launcher.tsc must be

created and placed in the \My Documents\TracerPlus7\SystemInfo\Skins folder. An example
Launch file is located in the Appendix of this manual. The file is made up of the following tags.

Important: When modifying the Launcher file the “useroverride” attribute must be set to true.
When set to false TracerPlus will attempt to modify the launcher file when session setting
changes are made and overwrite any user changes to the launcher file.

This is the root node (or tag) of the Launcher file. It can contain the version

<launcher> .
attribute.
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useroverride

The useroverride attribute must be set to true if the user wishes to modify the
Launcher file.

The starting node (or tag) of the individual launch pages to be created. (Tag

< >
pages must be closed with </pages>.)
To create a new launch tab the page tag is used. This tag contains the page
<page> . .
index and the name attributes.
page index | A zero based index of the pages. (The first page should be labeled "0")
name This attribute defines the actual visible name which appears on the new tab
being created. (example "View Data")
. The sessions tag marks the beginning of the session being added to the current
<sessions>
page.
. Use the session tag to define a new session to be added to the current page
<session> . .
and to encapsulate session attributes.
. The zero based index of the session this shortcut should point to.(The first
index . nAn
session should be labeled "0")
caption The text which will display below the session icon.
The location on the screen where the shortcut will be displayed. This can be a
cell value between 0 and 8 with 0 being the top left cell, and 8 being the lower right
cell.
Use the "view" attribute to specify whether the shortcut will open the data
. entry screen or the view data screen. Options are 1 — View Data, and 2 — Data
view ) . o
Entry Screen. Other view options ( 3 and up) are reserved for program specific
shortcuts and should not be used or altered.
Use the "icon" attribute to define a custom icon to be displayed for the session
icon shortcut. This should be a 28x28 pixel bitmap (.bmp) image, with a color depth

of no more than 255 colors. The bitmap file will be placed in the Skins folder

The Launcher Shortcut

When using the Session Launch screen an icon on the file menu will appear to the right of the
Help menu. This icon is used to return to the Launch screen. Pressing this at any point will return
the user to the launch screen on the last tab used.
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Once sessions are configured, it is customary to implement password protection so field
personnel cannot alter the session settings. When a Password is set, a user is required to enter
this Password to access any areas protected by the TracerPlus Admin Settings. Administrators
commonly Enable Protection for Session Settings and Field Settings. These settings can be
more efficiently configured in TracerPlus Desktop. In addition, Desktop provides more
configuration features allowing for more precise management of multiple users. As with all
configuration features of TracerPlus, it is highly recommended that TracerPlus Desktop be used
to configure these settings.

However, in order to provide a smooth transition for previous TracerPlus Users, the previous
procedures for configuring Password Protection remains available as an alternative. These past
methods on how to set passwords and set protection levels for program settings and data are
described below.

9.1 Setting Passwords

1. Select Passwords from the Launcher. 2. Select Use Password

3. Enter your Password

4. Enter additional protection levels; Session

Settings, Field Settings, Delete One
Record, Delete All Records and Edit

Records
L) m ra
i R =
ISISEEIUS ] Require Login
Configure | Data Entry | View Data | password Settings
IlT IlT =y ] Use passwords
Session Field Printers
Settings Settings

Enable passwords for:

@ 95_; < [] Session Settings

<

Wireless Passwords ] Field Settings
Settings [] Delete one recard

[ ] Delete al recards
[] Edit Recards

Last Sync: 11/28/05-11:58:22

File Options Admin Help E|A File Dptions Admin Help E|‘

9.1.1 Enable Protection for
Session Settings

When protection is enabled for Session Settings, the user is required to enter a password to edit
or add sessions.
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Field Settings
When protection is enabled for Field Settings, the user is required to enter a password to edit or
add field information.

Delete One Record
When protection is enabled for Delete One Record, the user is required to enter a password to
delete a record from the data view screen.

Delete All Records
When protection is enabled for Delete All Records, the user is required to enter a password to
delete all records from the menu bar.

Edit Records
When protection is enabled for Edit Records, the user is required to enter a password to edit a
record.

9.2 User Logins

User logins can be used to restrict access to TracerPlus. To enable user logins, simply click the
Require Login checkbox from the Passwords screen. When enabled, users are presented with a
login screen before access to TracerPlus is granted. A valid username and optional password is
required. Through the login interface, administrators have the ability to limit access to any
given session on a user basis. See the TracerPlus Users file below for an example of a valid
users.tsc configuration file.

To enable user logins go to Admin=>Passwords and check Require Login.

x

iy |PTS TracerPlus & (4 11:50 €3

] require Lagin

A

rPassword Settings
[] Use passwards

Enable passwords for:
[] Gession Settings
[ Field settings
[] belete one recard
[] Delete all records
[] Edit Recards

File Options Admin Help El*

User Login Screen
When Require Login is selected, the next time TracerPlus is started the user login screen will be
displayed.
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:‘." PTS TracerPlus ot o 912 9

TracerPlus Login @

UserMame:
| |

Paszword:

| |

i23[1]2[3]a[5][6][7[8][9]0]-[=]w«
Tabja[wle[r [t][y[uli]o[p[[[]
caPlafsafrlg[n]i[k[1[;]"]
shitfz[x[c[v[b[n[m[,[.[/]+
culadl ” [\ ] [+[t]<]-=
=
Username
Enter a valid username, if the username is incorrect or does not exist the user cannot
continue.
Password

Enter a valid password for the current username. This password can be left blank.

Login
Once a valid username and password have been entered press Login to enter
TracerPlus.

Cancel
Press Cancel to exit TracerPlus from the Login Screen.

Configuring a TracerPlus User
TracerPlus users are defined in the users.tsc file in the TracerPlus system directory (\My
Documents\TracerPlus7\Systeminfo\System). The users.tsc file is a simple XML document

made up of two tags (<users>, and <user>). To define a new user, add a <user> tag between the

root <users> tag. A user tag has three attributes the name, password, and session mask. The
following is an empty user tag.

Empty User Tag

<users>

<user name="" password="" sessionmask="" />
</users>

Note: The users.tsc file will need to be created manually, as this is not created
during the installation process. Optionally, creation of this file is offered in our
popular ODBC Link PC application
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name
The name tag is used to define the new user’s login name.

password
Enter the new user’s password in the password attribute. This is an optional attribute.

Sessionmask

The session mask is used to define the sessions the current user can view. It is a simple
32 character (1 for each session in TracerPlus) string of 1’s and 0’s. 1 meaning the user
can view the session, 0 meaning they cannot. This is an optional attribute. If it does not
exist, the user has access to all defined sessions.

TracerPlus User Example

<user name="userl” password="swordfish”
sessionmask="11100000000000000000000000000000” />

In this example userl has a password swordfish, and the user can only view session
1,2,and 3.

9.3 Deploying Configured Sessions to Multiple Users

sk DESKTOP
{_ ™ OPTIMIZED

Deploying sessions to the mobile device has been made much more straightforward through
TracerPlus Desktop. In almost all cases, simply using the Build/Deploy option within TracerPlus
Desktop will be the preferred method. However, for the instances that TracerPlus Desktop is
unavailable, the alternatives are described below.

9.3.1 How to Copy One PDA Configuration to Other PDAs

All TracerPlus session configurations are saved in separate files (TracerPlus Session
Configuration Files) located in \\My Documents\TracerPlus7\Systeminfo\System.

Each saved session is named in the following format: “Sxx_config.tsc” where:
xx = the session unique identifier.

Example: Session 1 on your PDA would be named S01_config.tsc.

This file is available for backup of your existing session settings or is especially useful in
transferring settings from one PDA to any other PDA in your deployment.

To transfer session settings to another PDA, simply move this “Sxx_config.tsc” file to the \My
Documents\TracerPlus\SystemInfo\System folder on the destination PDA.
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Note: The Session identifier (xx) in “Sxx_config.tsc” is used to control what session
identifier is used in the destination PDA. If this session identifier already exists on the
destination PDA, those previous settings will be overwritten. If this session identifier
does not exist, this imported session is simply added as new.

9.3.2 File Names Used by TracerPlus

This section lists the various file names used by TracerPlus on the PC. Itis here for your
reference in deploying and troubleshooting your TracerPlus configuration.

Note that sessions are identified by their session number, e.g. “S01”, and fields are identified by

their field number, e.g. “F02” (with “S01F02” indicating the first session and second field).

Upload/Download Filenames:

Data Records S01_Data.txt (in the \Data subfolder)

Drop-Down Lists SO1F02.txt (in the \Data subfolder)

Session configuration  S01_config.tsc (in the \SystemInfo\System subfolder)
Registration Code registration.tsc (in the \SystemInfo\System subfolder)
Session names sessions.tsc (in the SystemInfo\System subfolder)
Main Launcher Screen Launcher.tsc  (in the Systeminfo\Skins subfolder)
Data Entry Form S01_entryskin.tsc (in the SystemlInfo\Skins subfolder)

Note: Any of the data files used can be set to automatically import simply by appending
the _auto suffix to the filename. S01_data.txt would become S01_data_auto.txt
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Appendix

Appendix Al:

dd
ddd
dddd

g8

hh

HH

mm
MM

MMM
MMMM

tIIIMIII

Yy

yyyy (also yyy)

Date and Time Formatting characters

The one-digit or the two-digit day.

The two-digit day. Single-digit day values are preceded by a zero.
The three-character weekday abbreviation.

The full weekday name.

The period and era string that is contained in the CAL_SERASTRING value
that is associated with the specified locale. Windows CE ignores this
element if the date to be formatted does not have an associated era or
period string.

The one-digit or the two-digit hour in 12-hour format.

The two-digit hour in 12-hour format. Single-digit values are preceded by
a zero.

The one-digit or the two-digit hour in 24-hour format.

The two-digit hour in 24-hour format. Single-digit values are preceded by
a zero.

The one-digit or the two-digit minute.

The two-digit minute. Single-digit values are preceded by a zero.

The one-digit or the two-digit month number.

The two-digit month number. Single-digit values are preceded by a zero.
The three-character month abbreviation.

The full month name.

The one-letter A.M. and P.M. abbreviation (that is, “AM” is displayed as
“A”).

The two-letter A.M. and P.M. abbreviation (that is, “AM” is displayed as
“AM").

The year is displayed as the last two digits, but with no leading zero for
any year that is less than 10.

The last two digits of the year. For example, 1998 would be displayed as
“98”,

The full year. For example, 1998 would be displayed as “1998".
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Appendix A2: The TracerPlus Session Launcher

Example Session Launch file
To create three tabs similar to these below, review the following Launcher.tsc file.

L ¥

¢ /5 |PTS TracerPlus ot ot e €I

£ 12|PTS TracerPlus ot ¢ 457 €3] 2 |PTS Tracerplus o 42 a5e €9

[IRCEriPius rRcEipius IS CEPiIusS

Lot Tracking | asset Track | Route [4[» ||[1at Tracking | Asset Track |Route [ 4] ] |[asset Track | Route Accounting | [«]»
Induct Raw  Create FG Pick and Ship Assets Receive Take Make Wi

Material Lot Pack Assats Phrysical delivery Deliveries
Wiew Raw Wienw

Material Aseets
File Dptions Admin Help E|A File Dptions Admin Help E|A File Dptions Admin Help E|A

Tab 1: Lot Tracking Tab 2: Asset Track Tab 3: Route Accounting

The following example will create the three sample pages shown above.

<launcher version="5.0.0" useroverride="true">
<pages lastselectedtab="0">
<page index="0" name="Lot Tracking">

<sessions>
<session index="0" caption="Induct Raw Material" cell="0" view="2" icon="" />
<session index="1" caption="Create FG Lot" cell="1" view="2" icon="" />
<session index="2" caption="Pick and Pack" cell="2" view="2" icon="" />

<session index="2" caption="View Raw Material" cell="3" view="1" >
</sessions>

</page>
<page index="1" name="Asset Track">
<sessions>
<session index="5" caption="Ship Assets" cell="0" view="2" icon=""/>

<session index="6" caption="Receive Assets" cell="1" view="2" icon="" />
<session index="7" caption="Take Physical" cell="2" view="2" icon=""/>

<session index="6" caption="View Assets" cell="3" view="1" />
</sessions>
</page>
<page index="2" name="Route Accounting">
<sessions>

<session index="11" caption="Make delivery" cell="0" view="2" icon=""/>
<session index="11" caption="View Deliveries" cell="1" view="1" icon=""/>
</sessions>
</page>
</pages>
</launcher>
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Appendix

Appendix A3: TracerPlus Keyboard Shortcuts

The following document provides information regarding navigation within TracerPlus using
keyboard shortcuts. This guide may be useful for any device but is especially relevant for any
device running without a touch screen.

Function

Key

Examples

Combo/List Box Item Select Up/Down Any combo/list box.
Sub-Form switching F1-F4 Field Settings General, After Scan, etc.
Tab Switching Left/Right Launcher, Wireless Status.

Window Scroll

Alt Up/ Alt Down

Field Settings.

Control/Button Selection

Tab

Any form with multiple controls.

Click/Un-Click Check box

Space bar

Allow checking/un-checking of check boxes.
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